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System Requirements 
Computer:  
 

IBM PC (or compatible) 

Operating System:  
 

Windows XP and Vista 

Minimum Software: Microsoft Internet Explorer 6.0, Windows Installer 3.1  
Microsoft .NET Framework 2*  
 

Display: Minimum 800 x 600 with 256 colours  
Recommended: 1024 x 768 with High Colour - 16-bit 
 

 
* If Microsoft .NET Framework 2 or Installer 3.1 is not detected during the installation set up process, 
they will be automatically installed prior to the Datalog application install. This will extend the installation 
time significantly.  
 

Installing the Datalog software 
 
USB users: Make sure the Datalog logger is not connected to the USB port prior to, or while, the Datalog 
software is being installed. 
 
• Log on as ADMINISTRATOR (or with equivalent access rights) on the system. 
 
• Close any open programs – you may need to restart your machine for configuration changes to 

be made.    
  
• Insert the Datalog CD ROM into the CD Drive. This is an auto play CD ROM, meaning that 

Windows should detect the presence of the CD and automatically start up the Datalog auto run 
program. If the Autorun program fails to start, use Windows Explorer to navigate the CD ROM 
contents and double click on the file setup.exe. 

 
• Follow the on-screen instructions to complete the installation of Datalog and its associated files 

onto the hard disc.  
 
• When the installation is complete, eject the CD ROM and store it safely. 
 
• Restart your system. 
 

Connecting an Interface or Data logger  
• Serial connection:  

Connect the interface/data logger to the serial port on the computer. Note which serial port you have 
connected to e.g. COM 1, as this information will be required when you start the Datalog software.   

 
• USB connection  

The first time a Datalog unit e.g. Q3, Q5, Q3+, Q5+ or 120 is connected to a USB port on the 
computer, the USB drivers will need to be installed.  
 
Connect the unit to the USB port on the computer. Windows will automatically detect a new device 
and install the drivers.  
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Starting the Datalog program for the first time  
Start the Datalog software e.g. Start ► Programs ► LJ Create ► Datalog Software.  
 
 

 
Select a User level 
The first time the Datalog program is opened a ‘Select Program Level window will automatically open. 
Select a suitable user level.  
 
• Level 1 is aimed at ‘start’ level (e.g. up to 9 years old).  
• Level 2 is aimed at ‘mid’ level (e.g. 9 – 15 years old) 
• Level 3 is aimed at ‘exam’ level (e.g.15 years plus).  
 
Note: The program level can easily be altered at anytime using the Level icon once a logging 
option has been opened. Click on the Level icon and cycle through the levels. The currently 
selected level will be saved when the Datalog program is closed.  
  
Select an Interface and Connection  
The first time Datalog is opened a ‘Select Interface’ 
window will automatically open to allow the correct 
interface and connection to be selected. 

 
(a) Select the correct interface from the drop-down menu.  

• Datalog for a Datalog data logger or interface 
• Flash Logger for the Datalog Flash Logger  
• Sense and Control for the Sense & Control or Sense & 

Control EasyLog. 
• Example Data for stored example data to show how sensor 

readings are displayed. If this option is selected you will not be 
able to collect data from your interface or data logger. 

 
(b) Select the appropriate connection i.e. either Serial or USB Port. 

• If you are connecting via a USB lead, select USB Port.  
• If you are using a serial lead, select Serial Port and then the number of the communications port 

used from the drop-down menu e.g. Communications Port (COM2). 
• If you are using a USB/serial adapter, select Serial Port and then the adapter from the serial ports 

drop-down list e.g. AMC232USBDH USB Serial Port (COM4). 
 

(c) If these settings will stay the same leave the ‘Show at startup’ box unticked.  
If the box is ticked (enabled) the ‘Select Interface’ window will automatically open when you next 
start Datalog, so you can check that the currently selected Interface and method of connection are 
correct. This is useful if you use different types of interface (e.g. both Sense & Control and Datalog 
120 units) or if the interfaces use different methods of connection (e.g. use both Datalog 100 units 
which connect via a serial port and Datalog 120 or Q3+ type units which connect via a USB port).  
 

(d)   Click on OK. The program will save the current selection.  
 
Note: To change this selection at any time, CANCEL any ‘failure to connect’ errors, select Interface from the 
File menu and alter the interface selection.  

 
 
Once a connection is established the Home page will open, click on the appropriate icon.  

 

(a) 

(b) 

(c) 

(d) 
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The Home page 
Home is the main navigation window, which 
contains the icons for all available options. 
 
The appearance of the Home page and the 
complexity of the toolbars and functions in the 
experiment options are altered by the user level 
selected. The more bars, the higher the user level.   

 
Note: To alter the user level while in the front page, click on the close 
icon on the Home window. Click on the Level icon to cycle through 
the levels. When you have selected the correct level, click on the 
Home page icon to continue.  

 
 

 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

EasyLog 
The Graph window will open pre-set to record 
sensor values continuously as a line graph 
until stopped.  
 
See page 10. 
 
 
 
 
 
 
 
Meters 
The Meters window gives an introduction to 
sensors and how they respond to change. Up 
to four section displays can be open at any 
one time and they can be any combination of 
sensors and displays. See page 8. 

 

 

 
The Home page at Level 2 and 3 

The Home page at Level 1 

Close 

Note: If the interface/data logger detected 
cannot use an option, it will appear greyed out 
e.g. the Set up and Retrieve Remote options 
will only be available for data loggers that 
support remote data collection.   
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Snapshot 
The Graph window will open pre-set to record 
sensor values on demand (manual sampling) 
with a bar graph display. 
 
See page 10. 

 
 
 
 
 
 
 
 
 

Graph 
The Graph window is set to record sensor 
values against a chosen time span as a 
line graph display. The window opens with a 
real time logging wizard from which the time 
span, interval between samples, start 
condition and triggers for the recording can 
be chosen. 
 
See page 11. 
 
 
 
 
 
 Scope 
A simple oscilloscope type display. The data 
from a sensor is redrawn continuously on the 
screen. Ideal for demonstration fast events 
where there are rapid changes such as ECG 
traces, sound waveform, etc.  
 
Note: Scope is not available when the User level is 
set to Level 1. 
 
See page 13. 
  
 

 
 
 
 
 

Timing 
Timing is used to allow students to study 
Time, Velocity, Acceleration, Momentum and 
Kinetic Energy relationships using switch-
type (digital) sensors such as Light Gates.  
 
See page 14. 
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Open File  
Used to load a previously saved .SSL or.sid file. 
Locate the correct file and click on open.  
See page 43. 
 

 
 
 
 
 
 

Open Worksheet  
To select and open a worksheet and its 
accompanying experimental set up file.  
See page 43. 
 
 
 
 
 
 
 
 
 
 
Open Setup 
To select and open an experimental set up 
file. This will pre-set the software for a 
specific operation.  
See page 45. 
 
Note: Open Set up is not available when the 
User level is set to Level 1.  
 
 
 
 
 
Set up Remote 
Used to set up the available options for capturing 
data while disconnected from the computer 
(remote). These options can include the duration 
of a recording, the time between each sample 
and triggers.  
See page 46. 
 
Note: Set up Remote is not available when the User 
level is set to Level 1.  
 
 
 
Retrieve Remote 
Use this option to retrieve a data set 
stored in your data logger’s memory. 
See page 47. 
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The Meters option 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When Meters is selected from the Home page, the window will open with live data being displayed 
from a sensor in a Numeric window.  
 
Click on the Start/Stop icon           to stop data being recorded.  
 
To begin recording click on the Start/Stop icon. 
 
• Up to four section windows can be open at any one time and they can be any combination of 

sensors and displays. 
 
• A section window can be opened either by clicking on the appropriate icon on the Toolbar or from 

the drop-down Display menu. 
 
• To alter the sensor displayed in a section, right click with the mouse in the section window and a 

Sensor Selection window will open. Select the sensor to display in that section from the list.  
 
• Click on the close button       to close a section window. 

 
• A section window can be maximized to fill the whole window by selecting the maximize button, 

 click again to return to ¼ screen size.  
 
• Click on the Home icon         to return to the Home page 
 
 

As soon as you open Meters or you click on the Start/Stop icon, the data is recorded 
‘behind the scenes’. This data can be transferred into the Graph window for display and 
analysis using the Transfer to Graph icon (or select from the Edit menu). When in Graph 
click on the Back to Meters icon                to return to the Meters window. 

 

 

Status bar 

Section window  

Close section window 

Maximise window 

Menu bar 
Toolbar 

Sensor and its unit 
of measurement 

Start/Stop icon  

 

User Level icon 

Right 
click 

 

Information window 
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Changes 
This is the simplest of all four sections. It displays a 
block of colour that changes to reflect the value being 
collected by the sensor.  
Colour changes happen within the span of a sensor’s 
limits. The minimum and maximum of these limits can 
be altered in Sensor Settings from the Display menu 
or Options icon. 
 
For example: 
Temperature - begins at light blue (coldest) and then 
works its way up to become dark red (hottest).  
Light - begins at black (no light), works through greys 
until it becomes white (full light). 
pH – simulates the colour change of universal indicator.  
Sound and other sensors – begin at dark green (minimum), becomes lighter until works through 
to bright green (maximum).  
 
Note: To alter the sensor displayed, right click in the section window and select the required sensor from the Sensor 
Selection window.  

Gauge 
This section will display a simple bar gauge that 
increases and decreases with the measured value. 

 
The scale on the left-hand side is divided into sections 
to correspond to the sensor it is representing. 
 
The maximum and minimum value recorded will be 
displayed on the right-hand axis by two short lines if 
Show Min Max from the Display menu is ticked. 
Use Reset Min Max from Display to reset these 
values. 

Dial 
This section displays a traditional dial whose pointer 
moves to the right as the measured value increases and, 
likewise, moves to the left as the value decreases. 
 
The scale around the dial is automatically set by the 
software to correspond to the sensor it is representing. 
 
Two thin lines will display the maximum and 
minimum value recorded if Show Min Max from the 
Display menu is ticked. Use Reset Min Max to reset 
these values. 

Numeric 
This section displays the currently measured value as a 
number.  
 
The maximum and minimum value recorded will be 
displayed if Show Min Max from the Display menu 
is ticked. Use Reset Min Max to reset these values. 
   
Decimal numbers can be switched off by deselecting 
Display Decimals in Sensor Settings from the Display 
menu or Options icon. Without decimals selected, the 
reading will be rounded up to a whole number.  
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Sensors  
The sensors are automatically identified when the Meter option is selected. To change sensors while 
Meters is open, simply replace the sensor with a different type. Meters will automatically change the 
sensor settings so that the correct calibration scales are displayed. 
 
To alter the sensor displayed in a section, right click with the mouse in the section window and a Sensor 
Selection window will open. Select the sensor to display in that section from the list.  
 
The display colour, decimals, name and the minimum and maximum limits of a sensor can be altered 
either from the Display menu or Options icon. See pages 28.  
 
To change the range of a sensor e.g. to alter the range of a Heart Rate sensor from Waveform to Beats 
per minute select Sensor Config from the Settings menu (see page 37). 
 

The EasyLog option 
If EasyLog is selected from the Home page, the 
graph window will open pre-set to record sensor 
values continuously as a line graph until 
stopped.  
This makes it ideal for experiments when the time 
of the recording is unknown. 

 
Datalog Q3 or 5 users:  A wizard will open, deselect the tick next to 
any sensors from which readings are not required.  

 
Click on the Start/Stop icon         to start recording.  
 
Logging will start with a time span of 30 seconds and when it has elapsed the time span will 
double automatically. This will continue until the recording is stopped by clicking on the Start/Stop 
icon.  
 
Choose EasyLog when an X vs. Y graph is required (to plot the readings of one sensor against 
another). Alter the X-axis to display a sensor (rather than time) – see page 27.     
 
 

The SnapShot option  
If SnapShot is selected from the Home page, the graph window will open pre-set to 
record sensor values on demand (manual sampling) with a bar graph display. 
 
When the sensor selection wizard opens, deselect the tick next to any sensors from which 
readings are not required.  

 
Click on the Start/Stop icon         to start 
recording.  
 
Click in the graph area to collect a 
sample.  
 
Click on the Start/Stop icon         to stop 
data being recorded.    
 
If you click on the Start/Stop icon again 
you will be given the option to add the 
new readings to the end of the existing 
data (if No is selected the existing data 
will be deleted). 
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The Graph option 
If Graph is selected from the Home page, the graph window will open pre-set to record sensor 
values against a chosen time span as a line graph display. The window will open with a real 
time logging wizard from which the time span, interval between samples, start condition and 
triggers for the recording can be chosen. (The options available will depend on the level you 
have selected to work at). When your selection has been made, click on Finish. 

 

The logging wizard  
 

    User Level 1 has a simple two stage logging wizard to set 
up the available options before capturing data.  
 
Stage 1: Sensor selection 
• Deselect the tick next to any sensors from which readings are 

not required. If sensors have been altered after start up, click on 
the Redetect button to identify the change of sensor.  

• Click on Next.  
 
Stage 2: Recording duration 
• Select the length of time that you want to record from the list. 
 

The interval between each sample and the number of samples 
will automatically alter when the time duration is selected. The 
range of recording times available will vary according to which 
data logger is used.  
 

• Click on Finish. 
 

• Click on the Start/Stop icon          to begin recording data.  
 
 
       User Level 2 and 3 has a three stage recording wizard.  
 
Stage 1: Sensor selection  
• Deselect the tick next to any sensors from which readings are not required. If sensors have been 

altered after start up, click on the Redetect button to identify the change of sensor.  
• Click on Next.  
 
Stage 2: Recording duration 
• Select the length of time that you want to record from the list. 
 
• Select the interval between samples being taken. 
 

The number of samples will automatically alter when the 
total recording time and the interval between samples are 
selected.  
The range of recording times will vary according to which 
data logger is used.  

 
If a very short recording and 
intersample time are selected 
then the recording will be in 
FAST mode. In this mode there 
will be no screen display of the 
data until the recording ends.  

 
Note: If you wish to view fast data as it is being recorded then use Scope – see page 13.  

 
• Click on Next. 

 

REAL TIME recording will change to 
FAST if a combination of very short 
recording and intersample times are 
selected  
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Stage 3: Select the Start condition as required.  
This is used to set the condition required for the recording to start. The choice of start conditions and 
triggers available on this page will depend on both the recording time selected and the data logger used.   
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                            
None - To begin recording as soon as you click on the Start/Stop icon.        

 
Trigger on Level  - To begin recording when the selected sensor is ‘above’, ‘below’, ‘rises above’ or 
‘falls below’ a set value e.g. when the value from a temperature sensor rises above 15ºC.  

 
 
 
                             
 
     
                                                
 
    

                                                                   
 
 
 
 

 
 

Trigger on Digital Condition- to begin recording when a digital sensor, connected to input A or B, is 
On, Off, Rising to On or Falling to Off. 
 
Note: This option will only become available if a FAST recording time is selected 
 
E.g.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
E.g. start conditions if FAST 
recording time is selected 

E.g. start conditions for REAL TIME 
recording time 

Above 
For example: - 
To start recording 
when the value from  
a temperature 
sensor is above 
15ºC. 

SET LEVEL 

Below 
For example: - 
To start recording 
when the value 
from a temperature 
sensor is below 
15ºC. 

SET LEVEL 

Rises above               
For example: - 
Logging will not start 
until the value rises 
up above the set 
level.  

SET LEVEL

Falls below  
For example: - 
Logging will not start 
until the value falls 
down to below the 
set level.  

SET LEVEL 

If Falling to Off is selected, 
logging will start when an object 
has passed through the light 
beam  

If Rising to On is selected, logging 
will start when the first part of the 
object breaks the light beam 
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Select any Pre Trigger requirements.  
 

Note: This option will only become available if a FAST recording time with a trigger on level or digital condition 
is selected.  
 
Pre-trigger will allow a percentage of samples to be stored before the trigger condition is met and 
the remainder to be taken afterwards. For example, if 1,000 readings are to be taken and a 25% 
pre-trigger is selected, 249 readings will be taken before the trigger condition is met and 750 on 
and after the trigger.  
 
Note: Sufficient time must be allowed to elapse for the pre-trigger samples to be taken e.g. at a relatively slow sample time 
of 100 milliseconds with 1,000 samples and a 25% pre-trigger, it will take 25 seconds to get to the pre-trigger position. 

 
• Click on Finish.  
•  
• Click on the Start/Stop icon.        Recording will start when the start condition you have selected 

is met. The recording will stop when the selected time span has passed.  
 
Note: If you want to stop recording before the time span has passed, click on the Start/Stop icon.     
 
If None was the selected trigger then the recording will start as soon as the Start/Stop icon is 
clicked.  
 
If recording REAL TIME, with a trigger on level selected, a ‘Waiting for Trigger’ message will appear in 
the status bar (below the graph). When the trigger condition is reached the recording will begin.  
 
If recording FAST with a triggered start, a recording data 
message will display (if there is sufficient time!) until the 
trigger condition is met. The data collected will download as 
soon as the recording has finished.  
 
 

The Scope option  
Scope models many of the functions of a simple oscilloscope. It displays ‘real-time’ plots (as they 
occur) from the value of a sensor versus time. Unlike a graph that has a beginning and an end, the 
scope trace is refreshed or ‘redrawn’ continuously as long as data is being measured.  
 
Make your selection from the control panel on the right hand section of the Scope window and then 
click on Start/Stop icon          to begin recording.  
 
Once data has been recorded, it can be treated in the same manner as 
normal graph data e.g. the X-axis altered from time Reading number.  
 
Note: Overlay and Pre-Log functions are not available.  
 
Timebase 
The duration / intervals that are available will depend on the method of 
connection to the computer and the type of interface connected.  
The fastest speeds (with an interval shorter than 20 ms) require both 
direct USB communication and an interface capable of fast logging.  
 
For example: 
When a Datalog 120 is connected via the USB port, the shorter time 
bases will be available.  
When Datalog 120 is used either connected via the serial port or a USB 
serial adapter, the fastest interval between readings will be 20 ms. 
The fastest interval between readings available for Datalog Q3, Q3+ or 
Q5 is 20 ms. For Q5+ the fastest interval will be 1 ms.  
 
 

 

 

User Level 2 & 3 
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The timebase (Interval between samples and Duration) can be changed during logging. Use Faster 
to decrease and Slower to increase the duration of logging time. 
 
When the interval between readings is 20 ms or slower, the timebase will be in roll mode. In this 
mode the graph trace is redrawn continuously. When you click on Start/Stop the trace displayed will 
‘freeze’ and the data will become visible in the table.  
 
When the interval between readings is 10 ms or faster, scope will be in trigger mode. 
 
Trigger Mode 
Normal – records a trace for the specified duration each time a specific starting condition (trigger) is met. 
Auto - operates in a similar way to Normal, but if after a second the specified start condition is not 
activated, a trace will be recorded. This feature is useful in testing that the trigger settings for an 
experiment are correct. The trace will continue to be updated at a frequency of once per second.  
Single Shot - records one single trace and then stops recording automatically. 
 
Trigger Edge 
Positive - the reading from a channel has to rise above a set value to trigger a recording.  
Negative – the reading from a channel has to fall through a set value to trigger a recording.  
 
Trigger Channel and Level 
• Select the Channel to be used for the trigger condition from the drop-down menu.  
• Click on the Higher or Lower buttons to change the threshold value for the trigger. An orange dotted 

line on the graph will mark the current level. 
 
Pretrigger Position 
• Allows a percentage of samples to be stored before the trigger condition is met and the remainder to 

be taken afterwards. A brown dotted line will mark the pre-trigger position on the trace. 
 

The Timing option 
The diagram below shows a typical apparatus set up for use with Timing. This option is used to handle 
data from switch-type sensors such as Light Gates and Timing mats which only have two states, ON or 
OFF. 
 
Connect the digital sensors being used to the interface. Measurements can be taken from either a single 
sensor connected to Input A, or from two sensors connected to both Input A and B. 
 
To perform calculations for Speed/Velocity, Acceleration, Distance, Momentum and Kinetic Energy, it is 
necessary to enter the parameters used in an experiment. For example, to calculate speed from A to B, enter 
the distance between the two digital sensors connected to A and B. 
 
 
 
In this set up Light Gates 
are connected to Input A 
and B on the interface 
and are used to monitor 
the movement of a cart 
down a track. An 
interrupt card is fixed to 
the top of the cart. The 
card will cut through the 
Light Gate’s infrared 
beam. 
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When Timing is selected from the Home page, the graph window will be pre-set to 
record as a bar graph display against reading number. The window will open with a 
timing wizard from which the measurements required, apparatus and its parameters, 
and units for display can be chosen (the options available will depend on the level you 
have selected to work at). When your selection has been made, click on Finish.  
 

The Timing Wizard 
    User Level 1 has a simple wizard to record Time or Speed at A, Time or Speed from A to B, 
or Time from A to A (stopwatch).  
 
 

Step 1 Step 2 Step 3 b 

• Time 
 
at A 
 

Units and decimal places 

 
 
from A to B 
 

Units and decimal places 

 

 
from A to A 
(e.g. Stopwatch) 
 

Units and decimal places 

    
Step 1 Step 2 Step 3 a Step 3 b 

• Speed 
 
at A 
 

Enter the length of the single 
interrupt card in millimetres Units and decimal places 

 
 
from A to B 
 

Enter the distance from the Sensor 
at A to the Sensor at B in metres Units and decimal places 

 
Step 1: Select whether you want to record Time or Speed. Click on Next. 
 
Step 2: Select whether you want to measure:  
 

Time Speed 
• at A • at A 
• from A to B • from A to B 
• from A to A (e.g. Stopwatch)  

 
Click on Next. 
 
Step 3: If a Time option was selected then the next page will be units and decimals – see 3b. If 
Speed was selected, the next page will be for entering the measurement required for the 
calculation of speed. 
 
3a: 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Velocity from A to B - enter the 
distance between the sensor 
connected to Input A and the sensor 
at Input B (in metres). Click on Next. 
 

Speed at A - enter the length of the 
single interrupt card that will pass 
through the sensor connected to Input A 
(in millimetres). Click on Next.  



Datalog            

 16

3b: Select the number of decimal places and the 
units for the display of calculated data from 
the drop-down menus. 

 
Click on Finish. 
 

Click on the Start/Stop icon. When a signal 
change from the digital sensor/sensors is 
received, the timing measurement will 
automatically be entered into the table and 
graph. The vertical axis scale automatically 
adjusts to match the largest value collected. 
 

 
       User Level 2 and 3  
The pages in the Wizard will vary according to 
the choice made in the previous step.  
 
Step 1: Select how you want to record the data. Click on 
Next. 
 
Step 2: Select whether you want to measure at A, at A or 
B, from A to B, at A then B, etc. Click on Next. 
 
Step 3: Select the apparatus/interrupter you will be using 
in the experiment. Click on Next. 
 
Step 4: Enter the measurement of the 
apparatus/interrupter required by the calculation. Click on 
Next.  
 
Step 5: Select the number of decimal places and the units 
for the display of calculated data from the drop-down menus. 
Click on Next. 
 
Step 6: Select, if required, to display any of the columns 
of data used in the calculation of the final set of data.    

 
 
 
 

Note: The option to show these columns are also available from 
Show Columns in the Settings menu.  
 
Click on Finish. 
 
 
LEVEL 2 and 3 choices are: 

Measure 
  User 

Level

 
Interrupter 

 
Measurement 

Time  at A 
 

1, 2, 3 - - 

 from A to B 
 

1, 2, 3 - - 

 from A to A   
e.g. Stopwatch 

1, 2, 3 - - 

 at A or B 
 

2, 3 - - 

 at A then B 
 

2, 3 - - 

 period at A   
e.g. Pendulum 

2, 3 - - 

Acceleration at A = Change in Velocity =    Speed A2 – Speed A1  =  
 Time Taken Time A1 to A2 
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Speed / 
Velocity 

at A 
 

1, 2, 3 Single interrupt card - length of card (mm) 

  
 

2, 3 Double interrupt card - segment length (mm) 

  2, 3 Picket fence - fence pitch  (mm) 
- calculation increment (see page 20) 

  
 

2, 3 Pulley - none 

 from A to B 
 

1, 2, 3 - - distance from A to B (m) 

 at A or B 
 

2, 3 Single interrupt card - length of card (mm) 

 at A then B 
 

2, 3 Single interrupt card - length of card (mm) 

 
Distance at A 2, 3 Picket fence - fence pitch (mm)  

- calculation increment (see page 20) 
  

 
2, 3 Pulley          - 

 
Acceleration at A 

 
2, 3 Double interrupt card - segment length (mm) 

   Picket fence - fence pitch  (mm) 
- calculation increment (see page 20) 

  
 

 Pulley - none 

  at A or B 
 

2, 3 Double interrupt card - segment length (mm) 

 from A to B 
 

2, 3 Single interrupt card - length of card (mm) 

 at A then B 
 

2, 3 Double interrupt card - segment length (mm) 

 change from A to B 
 

2, 3 Double interrupt card - segment length (mm) 

 
Momentum 
and Kinetic 

Energy 

at A 3 Single interrupt card 
 

- length of card (mm) 
- mass of object passing through A (kg) 

  3 Double interrupt card 
 

- segment length (mm) 
- mass of object passing through A (kg) 

  3 Picket fence 
 
 

- fence pitch (mm) 
- calculation increment (see page 20) 
- mass of object passing through A (kg)   

  
 

3 Pulley - mass of object passing through A (kg)   

 at A or B 3 Single interrupt card 
 

- length of card (mm) 
- mass of object passing through A (kg) 
- mass of object passing through B (kg) 

 from A to B 3  - distance from A to B (m) 
- mass of object passing through A (kg) 

 at A then A 3 Single interrupt card 
 

- length of card  (mm) 
- mass of object passing through A  (kg)

 change from A to A 3 Single interrupt card 
 

- length of card (mm) 
- mass of object passing through A (kg) 

 at A then B 3 Single interrupt card 
 

- length of card (mm) 
- mass of object passing through A (kg) 
- mass of object passing through B (kg) 

 change from A to B  3 Single interrupt card 
 

- length of card (mm) 
- mass of object passing through A (kg)  
- mass of object passing through B (kg)  

 
Raw Times  

(interrupt edge 
times) 

at A 
 

3 - - 

 at A or B 
 

3 - - 
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Measurements 
 

Measurement at A   
Uses one digital sensor connected to Input A. Timing starts when the signal from Input A changes (ON) 
and stops when the signal reverts back (OFF). 
 
• If Light Gates are used with a single interrupt card, the time measured is for how long the card 

took to pass through the sensor.  
• For a Push Switch it will be the length of time that the switch is kept depressed.  
• For Timing mats it will be the length of time someone stands on the mat.  
 
 
Measurement from A to A  
E.g. stopwatch 
Uses one digital sensor connected to Input A.  
Timing will start when the signal at input A changes (ON) and will continue 
until the signal at A goes OFF and then ON again.  
 
Period at A  
E.g. pendulum 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Measurement at A then A 
Uses one digital sensor connected to Input A. Time will be measured for a single interrupt card 
passing through a Light Gate (A1), and then returning back through (A2). E.g. for rebound collisions.  
 
Change from A to A 
Uses one digital sensor connected to Input A. The measurement will be for the change in value from 
A2 to A1 e.g. for a single interrupt card passing through a Light Gate and returning back through.  
 
Measurement from A to B 
Uses two sensors connected to Input A and B. A measurement is taken for the time an object takes 
to travel from the sensor at Input A to the sensor at Input B. Timing will start when the signal change 
at Input A is detected  and stops when the signal at Input B changes.  
 
Measurement at A then B 
Uses two sensors connected to Input A and B. Three measurements are recorded of an object 
travelling from the sensor at Input A to the sensor at Input B. The measurements are: 
1. Time to pass through Sensor A 
2. Time to pass through Sensor B 
3. Time to travel from A to B 
 
Measurement at A or B 
Uses two sensors connected to Input A and B. A measurement will be taken from whichever sensor 

Start the pendulum swinging, when it is moving 
freely click on the Start/Stop icon. 
  
Timing will start when the pendulum first passes 
through the Light Gate. When the pendulum 
passes back through, it will ignore the second 
signal change and will stop at the third change 
(when the pendulum arrives back at the Light 
Gate). The time shown will be for a complete 
period.  
 Point at which 

the pendulum 
starts and stops 
the recording

Back

Forward

A
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detects the change in signal level. The measurement will be the time to pass through either sensor A 
or sensor B. 
 
Change from A to B  
Uses two sensors connected to Input A and B. A double interrupt card is used to measure the 
acceleration at A and then at B. The measurement shown will be the change in acceleration (Acceleration 
at B – Acceleration at A).  
 
Distance at A 
Use the Picket fence or Pulley, with a Light Gate connected to Input A, to measure the distance moved. 
Distance is calculated using the step size of the Data Harvest Pulley, or the pitch length of the Picket 
fence. Each time a new gap in the Pulley or the pitch of the Picket fence is reached; the distance moved 
is known. 
 
Raw Times 
Timing is usually started when the solid black part of an 
interrupt card blocks the infrared beam on a Light Gate and 
changes the logic level from 0 to 1. When the clear part of 
the card is reached, the infrared beam is restored and its 
logic state changes back to 0 and the event time is taken. 
Raw times show the logic levels as 0 and 1 values with the 
time of the event.   

Apparatus 
 
Single Interrupt card 
Measure the solid part of the card that will pass through the Light 
Gate (mm). Speed is calculated using the length of the interrupt 
card divided by the time taken for the card to pass 
 
 
 
Double Interrupt card 
The two segments of a double interrupt card 
must be equal in width. Measure the solid part 
of the card that will pass through the Light 
Gate (mm). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Picket fence  
The picket fence is a multi-segmented 
interrupt card so a sequence of 
measurements will be taken.  
 
 
 

E.g. Average acceleration can be measured using a single 
Light Gate with a double interrupt card. Acceleration is 
calculated using the length of the segments on the double 
interrupt card.  

 
Acceleration = Change in Velocity  = 
                               Time taken 
  
   V2  Length of segment   - V1  Length of segment    
                  Time                           Time 
 

                              Time taken  

1              0              1              0    

l

l

l 

l  
Measure from the start of one black edge to the start of the next black edge.  

 

V2 

V1 

Time taken 
for velocity 
to change 
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To improve the accuracy of readings, a calculation increment can be applied to average the times 
over fewer pitches.   
 
Note: A calculation increment (of more than 1) will result in fewer measurements than the number of pitches on a fence 
might indicate. 
 
 
 
 
 
 
 
 
 
 
 
*Note: If a picket fence with a pitch length of 10 mm is used with buggy type investigations (which produce slower times 
than gravity investigations), the times can be averaged over less pitches so the calculation increment could be reduced to 5.  
 
When a Picket fence is used to measure speed or acceleration, the measurements shown are for 
instantaneous values e.g. i.e. it took this amount of time to travel this distance and the 
acceleration was.  
 
 
Spoked Pulley 
The measurements for the Spoked Pulley are pre-defined.  
 
The spokes on the pulley can easily interrupt the Light Gates beam 
to create false results. Wait until all is ready before you click on the 
Start/Stop icon.  
 
When a Spoked Pulley is used to measure speed or acceleration, 
the measurements shown are for instantaneous values e.g. i.e. at 
this distance, the speed was.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pitch length (l) Suggested calculation increment 
60 mm or more  1 

50 mm 2 
40 mm 2 
30 mm 3 
20 mm 4 
*10 mm 5 - 8 
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The Graph Window 
EasyLog, SnapShot, Graph, Scope and Timing use the graph window to display and analyse readings.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Toolbars 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Toolbars can be positioned at the top, bottom or left or right side of the graph. 
To move, position the mouse pointer over dotted line to the left of the toolbar, when 
it becomes a        symbol, click, hold down and drag to its new position.   
 

Start/Stop icon   
 

(Level 1, 2 & 3) 

Click on this 
icon to return 
to the Home 

page 
 

(Level 1, 2 & 3) 

 

Overlay - adds 
a new set of 

data without the 
previous set 
being erased 

 
(Level 1, 2 & 3 

Graph, Snapshot 
and EasyLog) 

Interval - find 
the time 
elapsed 

between two 
data points 

 
(Level 1, 2 & 3) 

 

Gradient - 
calculates the 
rate of change 

 
(Level 2 & 3 only) 

 

Notepad for 
entering 

information 
about an 

experiment 
 

(Level 1, 2 & 3) 
 

New - to set 
up a new 

experiment 
 

(Level 1, 2 & 3) 

Options - to 
change the 
way data is 
displayed 
 
(Level 1, 2 & 3) 

Values - to 
find the value 
at a selected 

point 
 

(Level 1, 2 & 3) 

Difference   
between 

the data at 
two points 

 
 (Level 1, 2 & 3) 

Area - calculates 
the area under a 

section of the 
graph 

 
(Level 3 only) 

 

Left click in the area 
below the graph to 

alter the option 
displayed 

Information toolbar 

Window dividers 

Data Value  
Boxes 

The graph area X-axis 

Y-axis 

Status bar 

Menu bar 

Toolbar 

Double 
left 
click in 
this 
area to 
enter a 
Title 

 
Right 
click 

 

User level 

Left click to the 
left of axis to 

alter the 
channel 

displayed. 
 

Right click for 
the Sensor 

Settings tab 
options 

Right click 
below the graph 
area for the X-

Axis tab options 
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With some logging options, the table 
area will automatically be exposed. If 
not, select Show Table from the 
Display menu. If it is not selected, then 
the graph will automatically fill the 
window.  
The table can still be exposed in this 
mode by dragging the window divider to 
the right i.e. position the mouse pointer 
over the window divider to the left of the 
screen, when it becomes a       symbol, 
click, hold down the mouse button, and 
drag to the right to expose the table 
area. 
 

Recording Data 
 

To begin recording, simply click on the Start/Stop icon.  
 
During logging the Start/Stop icon will show a red square.  
Click on this icon to stop data being recorded before the selected duration has passed. 
 
If you want too simply repeat the last experiment (with all of the settings the same) simply 
click on the Start/Stop icon again.  
 
If you want to graph a new set of data, without the previous set of data being erased, select 
Overlay before you click on the Start/Stop icon. (Not available in Scope or Timing). 
 
To set up a new investigation e.g. to change the duration of a recording in Graph, or to 
identify a change of sensors, select the New experiment wizard.  
 
To go from one option to another e.g. from EasyLog to Snapshot, select the Home page 
icon.   
 
 

Selecting Data 
To select individual readings: - 
Click on the reading in the table or on the graph. The reading will be highlighted in the table and marked 
with a cursor on the graph. 
 
To deselect readings:  
Click with the left 
hand mouse button in 
the area above the 
graph.  
 
To select more than one reading in a 
series: - 
• Click on the first reading of the series, 

hold down and drag the mouse to the 
last reading or  

• Click on the first reading of the series, 
hold down the SHIFT key and click on 
the last reading.  

 
The selected readings will be 
highlighted in the table and marked by 
a box in the graph. 

 

 

 

Window divider 

The table area The graph area 
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To select readings that are not in series: -  
Hold down the CTRL key and click on each 
reading or point in turn. 
 
The selected readings will be highlighted in the 
table and marked with cursor lines in the graph. 
 

 

 
 
 
 
 
 
 

Use selection  
To display a selection of the recorded data, select the data required from the table or graph area (so 
it its highlighted). Click on Use Selection from the Edit menu and the graph will alter to use the 
selected data only.  
 
If you save while the selected part of the data is displayed, then only the selected data will be saved, (not the full 
data set).   
 

Selection Wizard  
Selection Wizard from the Edit menu can be used to select 
readings at specified intervals. 
 
Type in the first and last reading of the selection and the interval 
between the readings (e.g. every 10th reading). Click on OK and the 
selected readings will be highlighted in the table and graph.   
 
If the ‘Use the selection’ box is ticked the graph will automatically alter 
to display only the selected data. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Previous Selection  
Use Previous Selection from the Edit menu to revert back to the previous selection.  
 

 

User Level 2 & 3 

User Level 2 & 3  

User Level 2 & 3 
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Analysing captured data 
There are a number of tools built into the graph window to allow the analysis of captured data.  
 
Note: Some of these tools will not be available when the X-axis is a data channel i.e. Interval, Difference, Gradient 
and Area.   
 
Click on Analysis in the menu bar to open the Analysis menu. 
 
 
 
 
 
 
 
 
 
 
 

Values  
Select the Values icon and move 
the mouse pointer into the graph 
area. A cursor will appear which can 
be moved around the graph using 
the mouse. 
 
Position the cursor at the point where 
information from the data is needed. The 
corresponding value will be shown in the data 
value box and highlighted in the table. The 
information box will indicate the time of the 
selected data point.  
 
If the X-axis is a sensor, then cross hair cursor 
lines indicate what the value from the sensors 
would be if they crossed at the cursor point.  
 
Click on the Values icon again to deselect.  
 

Interval  
Select the Interval icon. Click on 
the first point on the graph, hold 
down and drag the mouse to the 
second point  
 
A box will be drawn around the section 
of graph and highlighted in the table.  
 
The information box will display the time of 
the first point, the time at the second point 
and the interval between them.  
 
Click on the Interval icon again to deselect.  
 
Click in the title area (just above the graph 
area) to deselect any selected readings. 
 
 
 

 

Analysis menu 
at Users Level 1 

 

Analysis menu  
at Users Level 2 Analysis menu 

at Users Level 3 
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Difference 
Select the Difference icon. Click on 
the first reading to be used in the 
comparison, to give a fixed cursor at 
that point (shows as a brown or 
black line in the graph and table).  
 
Note: Alternatively click on the first reading 
and then select the Difference icon.  
 
Click on a second reading.   
 
The values in the data boxes will show the 
difference between the data at the two points.  
 
While Difference is still selected it is possible 
to repeatedly select a second reading to 
compare with the first.  
 
Click on the Difference icon again to deselect.  

Gradient  
This feature calculates the rate of 
change of data in the vicinity of the 
cursor. When the graph line is 
horizontal the gradient is zero and 
values are not changing. A positive 
gradient shows that values are 
increasing – the larger the 
gradient, the faster the change.  
The calculation is performed over two points 
either side but one of the cursor. 
 
Click on the Gradient icon and a vertical cursor 
with a small line will appear to indicate the 
slope of the graph for whichever data channel is 
currently selected on the  
Y-axis. The gradient value for all data channels 
will be shown in the data value boxes.  
 
Click on the Gradient icon again to deselect. A manual Best Fit line can be used to calculate the gradient 
between two points – see page 35.  

Area  
This feature is used to calculate and 
display the area under a chosen 
section of the graph.  
 
The calculation for area is performed on the 
data from all channels. The units correspond 
to the product of the Y and X-axis.   
 
Click on the Area icon. Click on the first 
reading, hold down and drag the mouse 
across the appropriate section of the graph. 
Shading lines will mark the section under the 
graph for whichever data channel is currently 
selected on the Y-axis. The values for area 
will be shown in the data value boxes.   
 
Click on the Area icon again to deselect. Click in the area above the graph to deselect any selected readings. 

1st Reading 

2nd Reading 

 

Difference 
in readings 

User Level 3 

 

User Level 2 & 3 
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Show Statistics  
Show Statistics calculates and displays statistical information about the data collected from the data 
channel currently selected on the Y-Axis.  
 
Select the appropriate data channel on the Y-Axis. Select Show Statistics from the Analysis menu.  
• Max (Maximum) – the highest value reading  
• Mean – the arithmetic mean. 
• SD (standard deviation) – the scatter of a series of 

measurements about their mean value  
• Min (Minimum) – the lowest value reading 
 
If only a part of the original graph is selected (e.g. by using 
Use selection) then the statistics will be calculated using the 
data from only the selected part of the graph.  
 
To switch statistics off, deselect Show Statistics from the Analysis menu.   

 

Displaying data 

Data Value boxes 
The value recorded by a sensor will be displayed in a data value box. The colour used in a data value 
box corresponds to the colour of the plotted line and the axis label on the graph. Each data channel is 
allocated a different colour i.e. channel one is red, channel two is blue, and channel three is green. 
These colours relate to the channel of data, not the type of sensor or the input number e.g. if 
Temperature sensors are used connected to Input 2 and 4 on the interface, they will be allocated to 
the first available data channels, Channel 1 (red), and Channel 2 (blue). See page 28 to change the 
channel colours. 
 
If ‘Example data’ is selected from the Interface menu, simulated data will be 
available. The data value box will be labelled as Sensor (%).  
 
The default display mode for the data in these boxes is Numeric. Right 
click in the data box and select a different display mode if required.  
 
The window divider can be used to resize the data value boxes 
i.e. position the mouse pointer over the window divider under the 
data boxes, when it becomes a      symbol, click, hold down and 
drag downwards.  
 

Axis display 
Click with the left hand mouse button in the space to the left of the graph area to alter the data 
channel displayed. Subsequent clicks will cycle the Y-axis through all the data channels open. 
Click with the right hand mouse button in this space to open the Sensor Setting tab option (see 
page 28).  
 
 
Click with the left hand mouse button in the space at the bottom of the graph area to 
cycle through the options available for whatever is currently displayed on the X-axis. 
 
1. Time - select between:  

• Elapsed Time – from zero until that point in seconds [ Time (s) ], 
• Elapsed Time in days, hours, minutes and seconds [ Time (ss), (mm:ss), (hh:mm:ss), 

(d.hh:mm:ss) ].  
• Absolute Time - the time & date from the start of recording until that point [ Absolute 

Time (hh:mm:ss), (d.hh:mm:ss) ]. 
2. Sensor - cycle through the data channels available. 
3. Reading Number - no choice is available 

Window divider 

 
Right 
click 

 

User Level 2 & 3 
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Click with the right hand mouse button in the space at the bottom of the graph area to open the X-Axis 
tab options. From this tab select whether you would like Time, Reading Number or Channel (e.g. 
sensor) displayed on the X-axis  
 

Display Options  
The options available to alter the overall graph display are 
available either from Display in the menu bar or from the 
Options icon.  

  
Note: Other display choices, e.g. Show or Hide Channels, 
Zoom, Title and Auto scale, which apply to an individual graph, 
are available by a right click in the graph area. See page 29 - 
30. 

 
 
Number of Graphs  
Select the radio button next to the number of graphs that you 
want displayed in the graph area. 
 
 
Graph type  
Use this tab to customise the appearance of the collected data in 
the graph e.g. the graph type, thickness of line, point style and grid. 
 
Choose whether you want to display readings as a line or bar 
graph.  
 
If Line Graph’ is selected, then individual readings are by 
default joined by a line. There is a choice of four different 
thickness of line or no line (none). The readings can be 
marked by a choice of symbols or remain unmarked (none). 
 

  
 
 
 
 
 
 
 
 
 
 
 

If Bar Graph’ is selected then readings will be shown as bars of colour 
 
If Show Grid is selected then a faint grid is marked on the graph. There is a choice between a fine and 
coarse grid. 
 
X-Axis   
From this tab select whether you would like Time, Reading 
Number or Channel (e.g. sensor) displayed on the X-axis  
 
Time - the selected time span is used for the X-axis.  
 
Reading Number - the X-axis will be set to the number of 
single readings taken from a sensor, without any regular time 
interval between them. This axis is used for Snapshot data. 
 

Line thickness Point Style Result
 None  
   None x  
 x  
   None   
   
   None   
   
   None   
 

 

The Display menu in the graph 
window - Users Level 2 and 3 
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Channel  - the X-axis will be set to use one of the data channels e.g. a sensor. This axis is used for an 
X vs.Y plot.   
 
Note: To alter the data channel shown on the X-axis, click with the left hand mouse button in the space at the 
bottom of the graph area to cycle through the data channels. 
 
Sensor settings 
From this tab the name and limits displayed for a data channel or 
sensor can be altered. 
 
Normally the full scale of a sensor is displayed on an axis e.g. the 
scale for a Temperature sensor will show a minimum of -30 to a 
maximum of 110˚C. If the scale of an axis is too large, the 
minimum and maximum limits displayed can be altered e.g. 
reduced to a minimum of 10 to a maximum of 50˚C.  
  
The name used for a data channel can also be changed e.g. from 
Temperature to Room Temperature.   
 
Name: Double click in the cell with the data channel/sensors name and type in the new name. The 
altered name will be marked by an asterisk. 
 
Minimum & Maximum: Double click on the cell with the Minimum or Maximum value and type in the new 
number. The altered number will be marked by an asterisk. 
 
 
 
To reset to the original name or scale, click to select the data channel and select Reset to Default Name 
or Reset to Default Min/Max. 

  
Click on OK to finish.  

 
Note: If the value from a sensor being recorded rises above the maximum or falls below the minimum limits that have 
been set, Graph will not be unable to accurately display the true value. 
 
Display Decimals  - Used to switch decimal numbers on and off from the display. If Display Decimals is 
not selected, the reading will be rounded up to a whole number.   
 
Note: While in Timing, the number of decimal places displayed can be 
altered - see Change Units on page 39.  
 
Colour  
From this tab the colour used by a data channel can be altered. 
 
Double click on the data channel/sensor name. A colour palette 
will open. Select the colour required and click on OK.   
 
Click on OK to finish.  
 
 
 
 
Individual graph choices  
Some display options i.e. Show or Hide Channels, Zoom, Auto scale 
and Title, are applied on an individual graph basis rather than to all 
graphs displayed. These are available by a right click in the graph area 
of the individual graph. 
 
 
 
 

 

 

 

 

‘Right click’ in the graph area 
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Show or Hide Channels 
The data from a channel or sensor can be hidden from view.  
 
Right click in the graph area and click on Show or Hide Channels. Deselect the tick next to any 
sensors or channels you want to hide.  
 
Example: 
In this example two graphs 
are open. Show or Hide 
Channels has been used to 
deselect one of the sensors 
from each graph.  
 
 
 
 
 
 
 
 
 
 

Zoom  
An area of the graph can be magnified so that it can be seen in greater detail. 
 
Right click in the graph area and click on the Zoom In 
option.  
 
Position the mouse pointer at the top corner of the area to 
be magnified. Click, hold down and drag the rectangular 
box over the area to be magnified. Release the mouse 
button to show the magnified area.   
   
To expand this magnified area further, right click, select 
Zoom in and repeat the above. 
 
Right click and select Zoom Out to zoom out by one step.  
 
Right click and select Zoom Off to return to the original 
graph.  
 

Auto scale  
This option scales the Y-axis by using the values of the data collected. Right click in the graph area 
and select one of the four choices. The graph will automatically be adjusted.  
 
Auto scale graph Min Max – applies the Auto scale to all the channels of data on the graph using the 
minimum and maximum limits of the data.   
Auto scale graph 0 to Max– applies the Auto scale to all the channels of data on the graph using a 
minimum value of zero with maximum of the maximum limit of the data.  
Auto scale channel Min Max – applies the Auto scale to whatever data channel is currently selected 
on the Y-axis using the minimum and maximum limits of the data. 
Auto scale channel 0 to Max - applies the Auto scale to whatever data channel is currently selected 
on the Y-axis using a minimum value of zero with maximum of the maximum limit of the data.  
 
Deselect to return to the original scale.  
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Title 
To add a title to a graph, either right click in the graph area and select Title or double click with the left 
mouse button above the graph area.  
 
Type in the text for the title.  
 

The Table display 
Sensors/channels columns can be hidden from view. Right click in the 
table area. Deselect the tick next to any sensors/channels you want to 
hide.  
 
The width of the columns in the table can be increased or decreased. 
Position the mouse pointer over the line in the column heading. Click, 
hold down and drag to adjust the width. 
 
 
 

The Comment column 
Once some data has been collected, you can add text to the Comment column in the Table. Double-
click on the relevant cell in the Comment column. A dialogue box will appear for you to type in text or 
numbers from your keyboard. 
 
To Edit, double-click on the comment to re-open the dialogue box and alter as required.  

 

Using Tools on the data 
Click on Tools in the menu bar to open the 
Tools menu. 
 
Note: Some tool options i.e. Predict, Delete Predictions and 
Add Text, which apply to an individual graph, are available 
by a right click in the graph area. See page 36. 

Notes 
Select Notes from the toolbar or from the Tools 
menu to open the notes window, which has basic 
text editing facilities. The text written in this window 
is automatically saved in a data file. Use this window 
to write notes that would be useful when setting up 
the experiment, information about how the data was 
collected, or your conclusions to the experiment.  

Test Mode 
Select Test Mode from the Tools menu to test that your sensor is operating correctly. The current 
value from the sensor will appear in its data value box. 
 
The Test option will be active until it is deselected or a recording is started.  
 

Smoothing   
Used to ‘even out’ the data of a selected line by applying a moving average. 
 
Select Smoothing from the Tools menu. Select the data channel that you want 
smooth from the drop-down menu. Click on the > button to smooth or < to reverse 
the process. The smooth level advances at one unit at a time for the > symbol 
and 5 units for the >> symbol. Click on OK when the smooth level is correct. 
 

Line 

 

Tools menu at 
Users Level 2 & 3 

 

 

Tools menu at 
Users Level 1 
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Pre-log or Post-log Functions  
Select Pre-log function from the Tools menu to produce a set of data that is created as logging 
progresses e.g. produce both a Distance and Velocity vs. time graph from the Motion Sensor. 
 
Note: Pre-log functions are not available in Scope.  
 
Select Post-log functions from the Tools menu to create a set of 
data from data that has already been recorded e.g. use the Voltage 
and Current data collected to calculate Power.   
 
• Select whether you want to use a pre-set function or a formula.  

Pre-set - gives information to help make creating the data set 
simpler.  
Formula - presents a symbolic formula for generating the data.  

 
• Select the pre-set or formulae from the drop-down lists.  

 
With Pre-set functions select the subject/topic area from the 
drop-down list, and then select the functions available within 
this subject. The white panel will give information about the 
calculation, units, etc.  
 
Pre-set functions 
SUBJECT  FUNCTION INFORMATION 
Electricity Resistance 

 
 
 
 
 
 

Calculates resistance from Voltage and Current data.  
 
When Current is A and Volts is V, make Multiplier = 1.  
When Current is A and Volts is mV, make Multiplier = 0.001   
When Current is mA and Volts is V, make Multiplier = 1000  
When Current is mA and Volts is mV, make Multiplier = 1 
 
For low resistances set decimal places to 3. 
 

 Power 
 
 
 
 
 
 

Calculates power from Voltage and Current data.  
 
When Current is A and Volts is V, make Multiplier = 1. 
When Current is A and Volts is mV, make Multiplier = 0.001. 
When Current is mA and Volts is V, make Multiplier = 0.001. 
When Current is mA and Volts is mV, make Multiplier = 0.000001 
 

   
Motion Velocity Velocity, calculated from position, distance or displacement data (first 

derivative). 
  
Enter the units as appropriate e.g.: 
Linear Motion – units (m) - m/s; (cm) – cm/s; (mm) – mm/s; (in) – in/s. 
Pendulum, units (deg) – deg/s.  
 

 Acceleration from 
position data or distance 
data   
 

Acceleration calculated from position or distance data (second 
derivative) as d2s or d2ϑ. 
                        dt2     dt2 
 
Enter the units as appropriate e.g.: 
Linear Motion – units (m) - m/s/s; (cm) – cm/s/s; (mm) – mm/s/s; (in) 
– in/s/s. 
Pendulum - units Angular acceleration – deg/s/s.  
- 

 Acceleration from 
Velocity data 
 
(Post-log only) 
 

Acceleration calculated from Velocity data (first derivative) as dv. 
                                                                                                  dt  
Enter the units as appropriate e.g.: 
Linear Motion – units (m) - m/s/s; (cm) – cm/s/s; (mm) – mm/s/s; (in) 
– in/s/s. 
Pendulum, Angular acceleration – deg/s/s.  
 

User Level 2 & 3 
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 Angular Acceleration 
from Angular Velocity 
data  
 

Angular Acceleration calculated from Angular Velocity data (first 
derivative)  
 
Enter the units as appropriate e.g.:  
Angular Velocity (revs/s) - Angular Acceleration, units revs/s/s 
Angular Velocity (rads/s) - Angular Acceleration, units rads/s/s 
- 

 Displacement from a 
reference point 
 
 
 

Displacement = the distance from a reference point.  
The distance value of the reference point is subtracted from the 
distance data to give the displacement.   
 
E.g. with an oscillating spring, the ‘reference point’ would be the distance 
value of the centre of the oscillation. The displacement required is the 
displacement from the centre of oscillation.  
 

 Pendulum - Linear 
Displacement 

Calculates the linear displacement along the arc of the pendulum 
oscillation. It is calculated from the midpoint of the oscillation. 
 
Assumption; the angles are small (less than 20˚) and sinR = R in radians 
 

 Displacement from 
Velocity 
 

Calculates the displacement from Velocity data.  

   
Energy Gravitational Potential 

Energy (G.P.E.) 
G.P.E. = Ep = mass (kg) x acceleration due to gravity (m/s/s) x 
distance (m). 
 
Use to calculate the change in potential energy of an object between 
two points in a gravitational field. 
 
E.g the GPE gained when a ball bounces to a certain height above the floor. 
 
∆Ep = m x g x ∆h 
 

 Kinetic Energy Kinetic Energy = [0.5 x mass (kg)] x velocity2 
 
 

 Pendulum – Potential 
energy 

Calculates the difference in the potential energy of the pendulum bob 
between the centre of the oscillation and any other position in the 
oscillation. 
 
The angular displacement data must be in radians before this 
function is used (see the Conversion pre-set functions). 
 

 Spring – Elastic 
Potential Energy 

Calculates the change in the elastic potential energy of the spring as 
a result of the displacement of the spring/mass system from the 
midpoint of the oscillation. 
 
Calculated as ½Fx (Joules)  
 

   
General Tare 

 
 
 

Use this function to subtract an offset from a Sensor’s readings 
(typically used to zero the value from a Sensor). Find the tare value 
before using this function.  
 
Note: Make the value negative or positive as appropriate e.g. (2) - (2) = 0,  
(-2) - (-2) = 0. 
 

 Asks for Value  
 

(Snapshot Pre-log only) 
 

Each time you click in the graph area to record a value, a dialogue 
box will appear for you to type in a number from your keyboard.  
 
Note: Enter a Name and Units as appropriate. 
 

 Manual Entry Use this function to create a column full of zeros so that your own 
data can be entered via the keyboard.  
 
(To enter data, double click in a cell and type in your own data). 
 

 Add a constant Use this function to add a number (constant) to each data point. 
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 Subtract a constant Use this function to subtract a number (constant) from each data 
point. 

 
 Multiply by a constant Use this function to multiply each data point by a number (constant).  

 
Note: Alter the number of decimal places as appropriate.  
 

 Divide by a constant Use this function to divide each data point by a number (constant). 
 
Note: Alter the number of decimal places as appropriate.  
 

 Moving Average 
(simple) 
 

Each value is the mean of the previous ‘a’ number of data points  

 Mean (x,a) 
 

The sum of all the values in a set of ‘a’ data points divided by ‘a’  
e.g. if a = 3, an mean will be calculated for each set of 3 data points.  
 

 Average of 2 Channels Adds and divides the data from two Channels to show the average of 
both channels. 
 
Note: Alter the number of decimal places as appropriate.  
 

 Average of 3 Channels Adds and divides the data from three Channels to show the average 
of all three channels. 
 
Note: Alter the number of decimal places as appropriate.  
 

   
Titration Asks for the Volume 

added 
(Snapshot Pre-log only) 

 

Each time you click in the graph area to record a value from the pH 
Sensor, a dialogue box will appear for you to type in a number from 
your keyboard. Enter the TOTAL volume added so far.   
 

 First derivative of pH Creates a sharp peak to identify the point of most rapid change in pH. 
 
 

 Convert Drops to 
Volume 
 
 
 

Use this function to convert ‘number of drops’ to a volume 
measurement.  
 
This function needs a value for the volume of one drop. Divide the 
volume in cm3 by the number of drops required to fill this volume e.g. 
1 cm3 = 27 drops, 1/27 = 0.037 cm3 per drop.  
 
Note: Alter the number of decimal places as appropriate.  
 

   
Spirometer Spirometer Air Flow to 

Volume 
This function converts Air Flow data from the Spirometer to Volume. 
 
Volume units = Litres (l) 
 

 Spirometer Volume drift 
correction 
 
(Post-log only) 
 

This function corrects Volume data (which has already been 
calculated from the Air Flow data) for drift.  
 
Note: Volume data must be available to select. The multiplier and constant 
values are pre-calculated.  
 

   
Channel Multiply Channel by 

Channel 
This function multiples the data of two Channels together  

 Divide Channel by 
Channel 

This function divides the data from one Channel by a second 
Channel  

 Subtract Channel from 
Channel 

This function subtracts the data of one Channel from a second 
Channel 
 

 Add two Channels 
together  

This function adds the data from two Channels together 
 

   
Oxygen % Saturation to mg/l This function converts Oxygen % saturation data to Oxygen in mg/l.  

 
You will need to supply the Air Pressure (default 101.3 kPa) and the 
Temperature (˚C). 
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Conversion  Convert Degrees 

(angles) to Radians  
Converts Degrees to Radians.   
 
For Pendulum (±20˚) adjust the minimum channel limits to -0.4 and 
maximum channel limits to 0.4.   
 

 Radians to Degrees 
 

Converts Radians to Degrees  

 Celsius to Fahrenheit Converts Celsius to Fahrenheit   
 Fahrenheit to Celsius 

 
Converts Fahrenheit to Celsius 

 Celsius to Kelvin 
 

Converts Celsius to Kelvin  

 
 

Formulae 
a Moving average  a dx/dt a sin(bx) + c 

ax + by Mean (x,a) axb + c a loge(bx) + c 

ax - by ax2 a/(x^b) + c a log10(bx) + c 

axy a/x2 + c a ty + c a exp(bt) + c 

ax/y ax2 + bx + c a t/y + c a sin(bt) + c 

a/x + c at2 + bt + c a cos(bx) + c a loge(bt) + c 

(x - a)/b a dy/dx a exp(bx) + c a logn(bt) + c 

 
 
• Click on Next. 
 
• Select the appropriate data channel/s to be used as the source from 

the drop-down list.  
 
 
• Click on Next. 
 
 
 
 
 
• Enter the details for the new set of data e.g. type in a name and 

units or alter the number of decimal places to be displayed. 
 

• Select whether the axis limits of this data should either expand to 
fit or use manual limits.  

   
Expand to fit - when the recording has finished, the axis will 
automatically redraw if data has exceeded the limits taken from 
the original data.  
 
Note: If the maximum value calculated by the function is less than the 
source channel limits use Autoscale (see page 29) on the data.    
 
Manual – use the limits as specified in the minimum and 
maximum boxes. 

 
• Enter any parameters required e.g. type in a multiplier, constant or scaler. Numbers can be negative 

or positive (make sure there isn’t a space between the + or – sign and the number).  
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If a Formulae is selected, a and b are constants i.e. a number or scaler, c is an offset or intercept 
number.  

• Click on Finish.  
 
• If you are using a Pre-log Function, click on the Start/Stop icon. Data will be calculated and 

displayed on the graph and table. Values will not be displayed in the data values boxes during 
logging.  
 

Best Fit  
Select Best Fit from the Tools menu to calculate and produce a straight line which fits most closely 
to the collected data. It can be applied to the whole set of data or to a selected part. 
 
Note: If you want to apply an automatic line of best fit to only a part of the collected data, make your selection before 
choosing Best Fit.  
 
• Select the method of Best Fit 

Automatic (computer calculated) - the line will be drawn automatically 
across the entire range of the selected data. 
Manual (drawn freehand) - lets you draw the line of best fit between 
any two points 

 
• Click on Next. 
 
• Select the Axes for the line of Best Fit  

Select Y-axis – select the data channel/sensor to which you want to 
fit to the line from the drop-down menu. 
Select X-axis – the current X-axis will be selected by default. If the  
X-axis is Channel, select the data channel to be used from the  
drop-down list. 
 

• If a part of the collected data was selected for an automatic line, 
choose whether you want to apply the Best Fit line to the selected 
data only.  

 
• Click on OK.  
 
If Automatic was selected, the line will be drawn automatically. 
 
If Manual was selected, click at the start point, move the mouse and a ‘rubber band’ line will follow, 
click at the end point.    
 
A manual best fit line can be adjusted. Click on the end point of the line, hold down and drag to its new 
position.  
 
To delete the best fit line, right click on the line and select Delete. 
 
Information shown  
Automatic: (y = bx + a), r2 = 
Manual: (y = bx + a) 
 
y = the data channel selected 
x = as selected (i.e. time, reading or a data channel) 
b is the constant of the slope (gradient between two points) 
a is the intercept  
 
R2 is a fraction between 0 and 1. A high r2 tells you the line came very close to the points of data. 
When r2 = 1, all points line up exactly on a straight line with no scatter (so knowing x would let you 
predict y perfectly).  An r2 value of 0 means there is no linear relationship between x and y (so knowing 
x doesn’t not help you predict y).  
 

User Level 2 & 3 

b = constant a = the intercept 
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Note: The r2 value is only available if an Automatic line is drawn.  

Show Calculation  
Use to show how a result has been calculated for a reading in Timing.  
 
Select a reading from the table, and select Show Calculation from the Tools menu. The formula and 
measurements used in the calculation will be shown.  
 
Click on Next to see the calculation for the next reading or Cancel to finish.  
 
Note: A calculation will not be available for data collected using a Picket fence or Pulley.  
 

 
 
 
 
 
 
 
 
 

 
 
 
 
Individual graph choices 
Some tool options i.e. Predict, Delete Predictions and Add Text are applied on an individual graph basis 
rather than to all graphs displayed. These are available by a right click in the graph area of the individual 
graph.  
 

Predict 
Used to anticipate the effect of a change to the measured parameter before data is recorded e.g. moving 
a Temperature Sensor from hot to cold water. Predict lines can be drawn on a graph to predict where you 
think the graph line will go.  
 
To make a Prediction: 
• Right click in the graph area and select Predict. 
 
• Click at the start point, move the mouse and a thick black line will 

appear. Use the line to draw a prediction on the graph. Click with the 
mouse button at different points on the graph to fix the line in 
position. Right click to stop, which will deselect Predict. 

 
• Record the data as normal to test the validity of your prediction.    
 
Predict can be reselected to make up to twenty predictions on a time 
graph or up to ten for an XY graph.  
 
To delete any unwanted prediction lines right click in the graph area and select Delete Prediction. Use 
the forward and backward buttons to cycle through the prediction lines. As each line is selected it will turn 
red on the graph. Click on the Delete button to erase the prediction. 
  

Add Text 
Used to annotate the graph with ‘text boxes’ that can be 
placed in any position in the graph area. Each text box 

 

Timing only   
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has a line which can be made to ‘point’ to a part of the 
graph to which it refers.  
 
• Right click in the graph area and select Add Text.  
 
• A dialogue box will open. Type in the required text and click 

on OK.   
 
Note: Select Enter on your keyboard to move to a new line.  
 

• Move the cursor to the point on the line that you want the 
label to refer to and click once.  

 
• A ‘ghost’ rectangular box will appear, move it to the required 

position for the label. Click and the label will appear. 
  
The label can be moved at any time - click on the label and drag using the mouse.  
 
To edit or delete a label, right click on the appropriate label and select Edit or Delete.  
 

Changing Settings 

Sensor Config (Change range and Calibrate) 
Note: This option is specifically for use with Smart Q sensors and cannot be used with Sense & Control and Datalog 
Interfaces.  
 
All Smart Q sensors are automatically calibrated but some have multiple ranges e.g. Oxygen, or are 
capable of user calibration e.g. pH. Sensor Config from the Settings menu can be used to select a 
suitable range or to allow the user to adjust the calibration constants. 
 
Change Range 
Used to select the correct range for an experiment e.g. to alter the 
range of a Light Level Sensor from Lux to % Transmission. 
 
• Select the sensor requiring configuration from the list (it will be 

listed using its current range). 
 

• Click on the Change Range button.  
 
 
 
 
 

The range currently selected will be 
highlighted. 

 
Note: If no choice is available a message to say 
‘This Sensor does not have multiple ranges’ will be 
displayed. 

 
• Select the required range and click on OK. 

 
• Close Sensor Config. Click on New          and then Finish for the change in range to be detected.  
 
The sensor range setting will be retained until changed by the user. 
 
 
Calibrate Sensor 
All Smart Q Sensors are supplied calibrated. Certain Sensors allow the user to adjust the calibration 
constants to the conditions of the experiment. This option allows the user to adjust the sensor reading at 
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either two or three points in its range. The adjustments made will affect the whole Sensor range, 
between and beyond these points. The accuracy of the user calibration will depend upon the number of 
calibration points used and their spacing. 
For example: 
The pH Sensor has a default calibration set for operation at a temperature of 25oC. If the samples 
being measured are at a lower or higher temperature, then this default calibration may be improved by 
a ‘User calibration’. Buffer solutions of a known pH are used to set the values for the calibration points. 
It is essential that the buffer solutions used are at the same temperature as the samples in the 
experiment and that the pH value entered is the value of the buffer at that temperature. For example, a 
buffer solution with a pH of 7.01 at 25oC, can change its value to 7.10 at 5oC, or 6.98 at 40oC.      
 
• Select the Sensor requiring configuration from the list 
• Click on the Calibrate Sensor button 
 

Note: If no choice is available a message to say ‘This sensor does not have User Calibration’ will be displayed. 
 
• If only two samples are available for setting the 

calibration points, click to deselect the tick in the ‘Use 
Three point calibration’ box. Only the First and Last 
calibration points will then be available.  

• Type in the value of all the buffers that will be used. 
• Place the Sensor in the sample with the lowest value 

e.g. pH 4 buffer solution. When the displayed reading 
stabilizes, click on the Next button & the ADC value 
will automatically be entered into the First Values 
box.  

• Place the Sensor in the mid range sample value e.g. 
pH 7 buffer solution. When the displayed reading 
stabilizes, click on the Next button & an ADC value 
will automatically be entered into the Second Values 
box.  

• Place the Sensor in the highest value sample e.g. 
buffer solution of pH 10. When the displayed reading 
stabilizes, click on the Next button & an ADC value 
will automatically be entered into the Last Values 
box.  

• A message to say ‘The User range has been programmed‘ will be displayed. Click on OK. Disconnect 
and reconnect the Sensor from the Datalog unit.  

 
The User calibration values will be stored in the Smart Q Sensor and will be retained until recalibrated.  
 
• Click on Change Range button and select User Cal as the range and click on OK. 
 
• Close Sensor Config. Click on New         for the change in range to be detected.  

 
 
The lower section of the Calibrate sensor window displays the current reading from the selected sensor.  
 Default calibration – shows the current value recorded by the default calibration built into the Sensor 
 Current User calibration – shows the current value recorded by using the calibration points last 

configured by the user 
 Raw ADC – shows the value from the analogue digital converter in the Datalog unit in a range of 0 – 

65535. This value is used by the software to calculate the calibration constants. 
 
 
Logger Information 
Click on the Logger information button to check the type and the firmware version number of the Datalog 
unit being used.  
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Overlay  
Select the Overlay icon from the toolbar or Overlay 
Mode from Settings, to add a new set of data to the 
graph without the previous set of data being erased - 
useful for repeating an experiment to compare data.  
 
Note: This option is not available in Scope or Timing.  

Toolbar  
These options let you choose whether to see small or large icons, 
and whether the icons show text.  
 
Smaller icons without text can be useful on low resolution displays, 
as it gives more space to the main graph area. 
 
 

Show Columns  
To show data used to calculate the final result select Show Columns from the 
Settings menu in Timing.  
 
Tick the box next to any columns you would like displayed from the list. The columns available will vary 
depending on the Timing mode selected.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change Units  
Select Change Units from the Settings menu to specify the units and number of decimal places 
displayed (0 to 0.000000) in Timing. Each measurement has its own drop-down menu. 
 

 
 
 
 
 
 
 
 
 
 
 

Show Data as  
Data can be recalculated in another form without having to repeat an experiment using Show data as 
from the Settings menu.  The Timing Wizard will open, select how you want to show the current data and 
enter any measurements required for the calculation.  E.g. recalculate Distance data collected using a 
picket fence to show Speed.   

 Units 
Time ms, s  
Distance mm, cm, m 
Speed/Velocity mm/s, cm/s, m/s, mph, km/h 
Acceleration mm/s2, cm/s2, m/s2 
Momentum g m/s, kg m/s 
Kinetic Energy mJ, J 

Timing  

Timing  

Snapshot,  
EasyLog 
and Graph    

Timing  
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Deleting data 
Delete selected  
Select the data that you want to delete – see page 22. Select Delete selected from the Edit menu and 
confirm the deletion of the currently selected data. 
 
If the data is recorded with a constant time interval between readings (Graph and EasyLog), the data will 
be deleted but the time intervals will remain consistent. If readings are displayed as joined by a line, it will 
redraw between the data points.   
 
If data is recorded with an inconsistent time point (Snapshot), both the data and reading number will be 
deleted and the graph will redraw.  
 
Delete Data Sets  
Use Delete Data Set from the Edit menu to erase an entire set of 
data.  
 
Choose the channel of data to erase from the drop down menu. 
Click on Erase and confirm the permanent deletion of the data 
set from that channel.  
 
Note: Once a data set has been deleted there is no recover option. 
 

Merging Data  
Merge with file       
Select Merge with file from the File menu to merge the current data with a saved .SSL file. The data 
must be recorded with a time base (not suitable for Snapshot data) and the intersample time of the data 
must be the same for both.  
 
Note: You may find it best to set up a recording using a method in which the intersample time for the recording is 
specified e.g.  Graph rather than using EasyLog if you intend to merge the resulting files 
This option is not available at User Level 1 & 2. 
 
Retrieve and Merge     
Lets the current data merge with a data set retrieved from an Datalog data logger. The data 
must be recorded with a time base (not suitable for Snapshot data) and the intersample time of 
the data must be the same for both.  
 
Note: You may find it best to set up a recording with a specified intersample time e.g. using Setup Remote, to ensure 
the interval between samples is the same (rather than EasyLog) if the intention is to merge the resulting data. This 
option is not available at User Level 1 & 2. 
 

Edit Menu 
Item Available  in Description 
Copy Table EasyLog, Snapshot, 

Graph, Scope, Timer 
Used to copy the current Table onto the clipboard 
from where it can be pasted into spreadsheet, word 
processor or desktop publishing applications. 
 

Copy Graph EasyLog, Snapshot, 
Graph, Scope, Timer Used to copy the current Graph onto the clipboard 

from where it can be pasted into word processor or 
desktop publishing applications. 
 

Copy Window Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timer 

Used to copy the current Datalog window (as 
displayed on the screen) onto clipboard from where it 
can be pasted into word processor or desktop 
publishing applications. 
 

Transfer to Graph 
 

Meters only See page 8. 

User Level 3  

User Level 2 & 3 

User Level 3 
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File Menu  
Item Available  in Description 
Home Meters, EasyLog, 

Snapshot, Graph, 
Scope, Timer 
 

To return to the Home page 

New EasyLog, Snapshot, 
Graph, Scope, Timer 
 

Use to set up a new recording e.g. opens Logging wizard. 
 

Open  EasyLog, Snapshot, 
Graph, Scope, Timer 
 

Use to load previously saved data file. Locate the correct Datalog file 
(.SSL) or .SID file and click on Open. 

Save EasyLog, Snapshot, 
Graph, Scope, Timer Provided the file has been saved previously, the data will be 

automatically saved, retaining the name given the first time it was 
saved. 
 
Notes: If you Save while only a selected part of the data is being used then only the 
selected data will be saved.   
 

Save As EasyLog, Snapshot, 
Graph, Scope, Timer A dialogue box will open to allow the captured data to be saved as a 

Datalog file using a filename and destination of your choice [default 
location is to the currently logged on user’s My Documents 
folder\Datalog Files\Data Files]. Saved as .SSL type. 
 
Note: The Save or Save As options are not available in Meters as the data collected is 
live, but data recorded ‘behind the scenes’ can be transferred into the Graph window and 
then saved.  
 

Save Setup 
 

Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timer 

The settings for an experiment can be saved as a Setup file. This 
allows the use of the same settings at a future date without going 
through the set-up process.  
 
• Set up the parameters for the experiment  
• Click on Save Setup from the File menu. Enter a name for the 

experiment (which will be displayed in the Worksheet/Setup window) 
and click on OK. 

 
 
 
• Type in a file name for the Datalog Setup file *.SSS [default location 

is to the currently logged on user’s My Documents folder]. Click on 
Save.  

 
See page 44 for further information. 
 

Printing   
Page Set-up Meters, EasyLog, 

Snapshot, Graph, 
Scope, Timer 

To set up the print output to suit your printer. Use to select whether to 
print in landscape or portrait format. 
 

Print Meters only 
  

To print out a copy of the current screen display 
Print Graph EasyLog, Snapshot, 

Graph, Scope, Timer 
 

To print out a copy of the current graph 

Print Table EasyLog, Snapshot, 
Graph, Scope, Timer To print out a copy of the current table.  

 
Note: A table can use multi-pages to print. The number of pages that would be used and 
the printer format can be established by using Print Preview Table. 
  

Print Preview   Meters only  
 

Use to view the printout before printing. 
Print Preview  
Graph  

EasyLog, Snapshot, 
Graph, Scope, Timer 
 

Used to view the printout of a graph before printing. 

Print Preview 
Table 

EasyLog, Snapshot, 
Graph, Scope, Timer 
 

Used to view the printout of a table before printing. 
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Transfer to 
Excel 
 
(User Level 2 
and 3 only) 
 

EasyLog, Snapshot, 
Graph, Scope, Timer Transfers the collected data into Microsoft Excel, if it is installed 

on your computer. Excel will open a new worksheet with column 
headings and data imported from Datalog.  
 

Export as a 
.SID file 
 
(User Level 2 
and 3 only) 

EasyLog, Snapshot, 
Graph, Scope, Timer Export (save) the collected data in a .SID file format. 

 
Note: Files saved in .sid format can be loaded into any program able to load text 
files or CSV (comma separated values) files. Files contain information about units 
and measurements to allow free exchange of data between a variety of data 
logging software systems 
 

Interface 
selection  
 

Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timer 

Used to select the correct type of interface and the type of 
connection used. 
 
If the ‘Example Data’ option is selected you will not be able to 
collect data from your interface or data logger. The example 
sensors will replicate data from four sensors working at different 
values.  
 
The program will save your selection so it will be automatically 
configured when Datalog is next used.  
 

Exit Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timer 
 

To quit Datalog 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Datalog            

 43

Home page Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open File 
Use Open File to load a previously saved data file.  Locate the correct Datalog (.SSL) or .SID file and 
click on Open.  
 
Note: Default location is the currently logged on user’s My Documents folder.  
 

Open Worksheet 
Open Worksheet is used to open an experimental worksheet together with the software pre-configured 
for an investigation. Experimental worksheets can be written by the user, or purchased as pre-prepared 
files. Some example pre-prepared files are included with this program.  

 
 
 
Open the Investigations folder. 
 
Open the Workroom files folder. 
 
 
 
Locate the investigation and double click on its 
setup file.  
 
 
 
 
 
 
 
 
The worksheet for the investigation will open.  
 
Setup the apparatus as required.   
 
Click on the Launch icon to open 
the logging option pre-set to record 
this investigation.  
 
Note: The Cancel icon can be used to 
close the worksheet and return to the 
folder window.  
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Use the To Experiment or To Worksheet icons to swap 
between the worksheet and the experiment window.  
 
 

Note: The Forward and Back icons will remain inactive until a hyperlink in the text is selected.  
 
 

To edit a pre-prepared HTML Worksheet  
The prepared worksheets can be loaded into a word processor application capable of loading and editing 
HTML files e.g. Microsoft Office Word 2003, and then edited.  
 
 
A workroom file has both a setup 
file and a directory (with the same 
file name), which contains an html 
file named index.html.    
 
 
 
 
 
 
 
 
 
• Open the word processor application e.g. Word 2003. Locate the appropriate index.html file e.g. from 

the C:\Program Files\DHG\Datalog Setup Files. 
• The file will load and be converted back to the applications format e.g. a. Word file.  
• Save any changes using the same file name and HTML format – index.html – (so the current 

worksheet is overwritten). 
 

To Save a Setup file 
• Set up the parameters of an experiment using the appropriate logging option i.e. EasyLog, Meters, 

Snapshot, Graph, Scope or Timing.  
 

E.g.  Select the Users level, recording times, interval between samples, any start conditions or pre-
triggers plus any options required for display i.e. show table, number of graphs, line thickness and 
point style, grid on/off, X-axis, name, minimum and maximum limits, title, predictions, deselected 
channels, pre-log functions, notes, overlay, etc. 

 
• Select Save Setup from the File Menu. 
 
• Type in a suitable name for the 

experiment - this is the name that will be 
displayed in the list of investigation lists. 
Click on OK. 

 
• The Save Datalog Setup file dialogue box will open. Alter the file name if required.   
 

Note: Default location is the currently logged on user’s My Documents folder.  
 

 
 

  

  

Setup file  
Directory 

 

 

Contents of the 
Drop 5 directory  

Index.html file  
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To associate a Worksheet to your Setup file 
• When you save the Setup file, make a note of the file name used 

and the save location. 
 

Note: Default location is the currently logged on user’s My Documents 
folder. 
 

• Create a new directory with exactly the same name as the Setup 
file, in the same location.  

   
• Load a word processor application capable of saving HTML format 

files e.g. Microsoft Office Word, Publisher or FrontPage. Create 
your worksheet document.  

 
• Save the document as an index.html file into the directory that has the same name as the set up 

file.  
 
Note: Ensure that the file is saved as .html - some versions of Microsoft Word will save web pages as .htm 
files, which will not be recognised by the setup. If so, type in the missing l (so .htm becomes .html). 
 
Note: Applications used to create HTML files (such as MS Publisher) may want to create more than just the 
index.html file e.g. pictures to go on the page that have been saved as GIF or JPG’s. If this is the case, ensure 
that all of the files are saved in the same directory. 

 
• Select Open Worksheet from the Home page in Datalog. Select the appropriate folder and then 

investigation from the list (using the name given for the investigation during the saving process). 
 
• The HTML worksheet will open. Click on the Launch icon to open the logging option pre-set to 

record the investigation.  
 

Open Setup 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use Open Setup to open the software pre-configured for an investigation. 
 
• Open the Investigations folder. 
 
• Open the Setup files folder. 
 
• Locate the investigation and double click on its Setup file. One of the logging options e.g. Graph will 

open pre-set to record this investigation.  
 
Note: A Setup that has an associated worksheet can be opened using Open Setup – the logging option will open 
without opening the worksheet.  

 

Saved Setup file

New directory with 
the same name
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Setup Remote  
Setup Remote is used to program a data logger to collect data independently from the computer. 
The collected data is stored in the logger’s memory to be retrieved by the computer at a later stage.   
  
Note: The Set up Remote option is only available for data loggers that support remote data collection. If the 
interface selected does not have this facility, the Remote option will either not appear or will be ‘greyed out’. 
 
Stage 1: Sensor selection  
• Deselect the tick next to any sensors from which readings are not required.If sensors have been 

altered after start up, click on the Redetect button to identify the change of sensor.  
• Click on Next.  
 
Stage 2: Recording duration 
• Select the total recording time from the list. 
 
• Select the interval between samples being taken. 
 

The number of samples will automatically alter when the total 
recording time and the interval between samples are selected.  
The range of recording times will vary according to which data 
logger is used.  

 
• Click on Next. 
 
Stage 3:  
• Select the Start condition as required.  
 

This is used to set the condition required for the 
recording to start. The choice of start conditions and 
triggers available on this page will depend on both 
the recording time selected and the data logger 
used.   

 
 
 
 
 

                          
When Enter Pressed - To begin recording as soon as you press Enter on the data logger.  
When you click on Finish the settings will be downloaded and a message will appear on the 
computer to inform that ‘The logger is now set up for remote logging’. Click on OK. 
The data logger can be taken away from the computer and placed in the recording position. It will 
not start logging until the Enter (or Go) button on the logger is pressed. 
 
Trigger on Level  - To begin recording when the selected sensor is ‘above’, ‘below’, ‘rises above’ or 
‘falls below’ a set value e.g. when the value from a temperature sensor rises above 15ºC.  
 
 
 
 
 

 
 
 
                             
 
 
                                                                                             

 
 
 

 E.g. start conditions if a FAST 
recording time is selected 

Above 
For example: - 
To start recording 
when the value from  
a temperature 
sensor is above 
15ºC. 

SET LEVEL 

Below 
For example: - 
To start recording 
when the value 
from a temperature 
sensor is below 
15ºC. 

SET LEVEL 

Rises above                
For example: - 
Logging will not start 
until the value rises 
up above the set 
level.  

SET LEVEL

Falls below  
For example: - 
Logging will not start 
until the value falls 
down to below the 
set level.  

SET LEVEL 

User Level 2 & 3 
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Trigger on Digital Condition- to begin recording when a digital sensor, connected to input A or B, is 
On, Off, is rising to on or falling to off. 

 
E.g. when used with Light Gates  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Trigger on Time - to begin recording at the time and date specified.  
• Click on the Now button to set the current time and date using your computer’s clock.  
• Alter Trigger on Time to a time and date in the future: 

Click on the hour, minute, or second number and then use the up/down arrows to scroll the 
number up or down.  
Click on the date drop-down arrow and select a future date from the calendar.    
 

• Select any Pre Trigger requirements.  
 

Note: This option will only become available if the recording is in FAST mode with a trigger on level or digital 
condition selected.  
 
Pre-trigger will allow a percentage of samples to be stored before the trigger condition is met and 
the remainder to be taken afterwards. For example, if 1,000 readings are to be taken and a 25% 
pre-trigger is selected, 249 readings will be taken before the trigger condition is met and 750 on 
and after the trigger.  

 
Stage 4:  
• Click on Finish. Recording will start when the start condition you have selected is met. Recording 

will stop when the selected time span has passed.  
 

Retrieve Remote 
This option is used to retrieve remotely captured data for display and analysis. Retrieved data can be 
used in the same way as real-time data i.e. it can be analysed, saved and printed. 
 
Note: This option will only be available for data loggers that support remote logging operation. 

 
Datalog users: 
Connect the data logger to the 
computer. Select Retrieve Remote 
from the Home page. A dialog box will 
open showing a list of the sets of data 
presently stored in the Datalog unit. 
 
 
The Date and Time of recording is set 
by the data logger. Type indicates the 
method of recording e.g. Analogue, 
EasyLog, Snapshot, and Timing.  
 

If Falling to Off is selected, logging will start when 
the object has passed through the beam  

If Rising to On is selected, logging will start when the 
first part of the object breaks the beam 
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For Q Advanced users, description will list a data set name.  
 
Select the required set of data and click on the Retrieve button.  
If the ‘Erase the Data set from the Logger after Retrieve’ box is ticked, the data set selected will be 
deleted after retrieval.  
 
Datalog Q 3 or 5 users: 
EasyLog or Remote data: Deselect the tick next to any sensors from 
which readings are not required. 
 
Timing Data: The Timing Wizard will open. Select how you want to 
retrieve the collected time data, the type of interrupter that was 
used and any measurement required for the calculation of the data.  
 
Sense & Control users:  
• Connect Sense & Control to the computer. Ensure it is switched ON (Manual) and is not logging. 
• Select Retrieve Remote from the Home page.  
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